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Notice

© Keysight Technologies, Inc. 1983-2015
1400 Fountaingrove Pkwy., Santa Rosa, CA 95403-1738, United States

All rights reserved.

No part of this documentation may be reproduced in any form or by any means (including electronic storage
and retrieval or translation into a foreign language) without prior agreement and written consent from
Keysight Technologies, Inc. as governed by United States and international copyright laws.

Restricted Rights Legend

If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is
delivered and licensed as "Commercial computer software" as defined in DFAR 252.227-7014 (June 1995), or
as a "commercial item" as defined in FAR 2.101(a) or as "Restricted computer software" as defined in FAR
52.227-19 (June 1987) or any equivalent agency regulation or contract clause.

Use, duplication or disclosure of Software is subject to Keysight Technologies' standard commercial license
terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than
Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no
greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (
November 1995), as applicable in any technical data.
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Layout Boolean Engine by Klaas Holwerda, v1.7 http://boolean.klaasholwerda.nl/bool.html

FreeType Project, Copyright (c) 1996-1999 by David Turner, Robert Wilhelm, and Werner Lemberg.
QuestAgent search engine (c) 2000-2002, JObjects.

Portions of the code Copyright (c) 1990-1996

The Regents of the University of California. All rights reserved. Permission is hereby granted, without written
agreement and without license or royalty fees, to use, modify and distribute the Ptolemy software and its
documentation for any purpose, provided that the above copyright notice and the following two paragraphs
appear in all copies of the software and documentation.

In no event shall the University of California be liable to any party for direct, indirect, special, incidental, or
consequential damages arising out of the use of this software and its documentation, even if the University of
California has been advised of the possibility of such damage.

The University of California specifically disclaims any warranties, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose. The software provided hereunder is on an "
as is" basis and the University of California has no obligation to provide maintenance, support, updates,
enhancements, or modifications.

Portions of this product include the SystemC software licensed under Open Source terms, which are available
for download at http://systemc.org/. This software is redistributed by Keysight. The Contributors of the
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SystemC software provide this software "as is" and offer no warranty of any kind, express or implied,
including without limitation warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be liable for any
damages of any kind including without limitation direct, indirect, special, incidental and consequential
damages, such as lost profits. Any provisions that differ from this disclaimer are offered by Keysight only.

Motif is a trademark of the Open Software Foundation.
Netscape is a trademark of Netscape Communications Corporation.
UNIX is a registered trademark of the Open Group.

Microsoft, Windows, Windows NT, Windows 2000, and Windows Internet Explorer are registered trademarks
of Microsoft Corporation in the United States and other countries.

Pentium is a registered trademark of Intel Corporation.
Acrobat, PDF, and PostScript are registered trademarks of Adobe Systems Incorporated.

FLEXIm and FLEXnet are registered trademarks of Flexera Software LLC Terms of Use for Flexera Software
information can be found at http://www.flexerasoftware.com/company/about/terms.htm

Netscape Portable Runtime (NSPR), Copyright (c) 1998-2003 The Mozilla Organization. A copy of the Mozilla
Public License is at http://www.mozilla.org/MPL/

FFTW, The Fastest Fourier Transform in the West, Copyright (c) 1997-1999 Massachusetts Institute of
Technology. All rights reserved.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of
their respective owners.

Cadence, Allegro, Assura, Dracula, SKILL, Spectre, and Virtuoso are registered trademarks of Cadence Design
Systems, Inc. in the United States and/or other jurisdictions.

Mentor, Mentor Graphics, Board Station, Calibre, and Expedition are registered trademarks of Mentor
Graphics Corporation in the United States and other countries.

SystemC is a registered trademark of Open SystemC Initiative, Inc. in the United States and other countries
and is used with permission.

Gradient, HeatWave and FireBolt are trademarks of Gradient Design Automation Inc.
The following third-party libraries are used by the NlogN Momentum solver:

Metis 4.0, Copyright © 1998, Regents of the University of Minnesota", http://www.cs.umn.edu/~metis, METIS
was written by George Karypis (karypis@cs.umn.edu).

Intel@ Math Kernel Library, http://www.intel.com/software/products/mkl
HSPICE is a registered trademark of Synopsys, Inc. in the United States and/or other countries.

DWG and DXF are registered trademarks of Autodesk, Inc. in the United States and/or other countries.
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MATLAB is a registered trademark of The MathWorks, Inc. in the United States and/or other countries.
SuperLU_MT version 2.0

SuperLU Copyright: Copyright © 2003, The Regents of the University of California, through Lawrence
Berkeley National Laboratory (subject to receipt of any required approvals from U.S. Dept. of Energy). All
rights reserved.

SuperLU Disclaimer: THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

7-zip
7-Zip Copyright: Copyright (C) 1999-2009 Igor Pavlov.
Licenses for files are:

1. 7z.dll: GNU LGPL + unRAR restriction.
2. All other files: GNU LGPL.

7-zip License: This library is free software; you can redistribute it and/or modify it under the terms of the GNU
Lesser General Public License as published by the Free Software Foundation; either version 2.1 of the License
, or (at your option) any later version. This library is distributed in the hope that it will be useful,but WITHOUT
ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE. See the GNU Lesser General Public License for more details. You should have received a copy of
the GNU Lesser General Public License along with this library; if not, write to the Free Software Foundation,
Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA.

unRAR copyright: The decompression engine for RAR archives was developed using source code of unRAR
program.All copyrights to original unRAR code are owned by Alexander Roshal.

unRAR License: The unRAR sources cannot be used to re-create the RAR compression algorithm, which is
proprietary. Distribution of modified unRAR sources in separate form or as a part of other software is
permitted, provided that it is clearly stated in the documentation and source comments that the code may
not be used to develop a RAR (WinRAR) compatible archiver.

7-zip Availability: http://www.7-zip.org/
AMD Version 2.2
AMD Notice: The AMD code was modified. Used by permission.

AMD copyright: AMD Version 2.2, Copyright © 2007 by Timothy A. Davis, Patrick R. Amestoy, and lain S. Duff.
All Rights Reserved.
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AMD License: Your use or distribution of AMD or any modified version of AMD implies that you agree to this
License. This library is free software; you can redistribute it and/or modify it under the terms of the GNU
Lesser General Public License as published by the Free Software Foundation; either version 2.1 of the License
, or (at your option) any later version. This library is distributed in the hope that it will be useful, but WITHOUT
ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE. See the GNU Lesser General Public License for more details. You should have received a copy of
the GNU Lesser General Public License along with this library; if not, write to the Free Software Foundation,
Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and the Availability of
the original version is retained on all copies.User documentation of any code that uses this code or any
modified version of this code must cite the Copyright, this License, the Availability note, and "Used by
permission." Permission to modify the code and to distribute modified code is granted, provided the
Copyright, this License, and the Availability note are retained, and a notice that the code was modified is
included.

AMD Availability: http://www.cise.ufl.edu/research/sparse/amd

UMFPACK 5.0.2

UMFPACK Notice: The UMFPACK code was modified. Used by permission.

UMFPACK Copyright: UMFPACK Copyright © 1995-2006 by Timothy A. Davis. All Rights Reserved.

UMFPACK License: Your use or distribution of UMFPACK or any modified version of UMFPACK implies that
you agree to this License. This library is free software; you can redistribute it and/or modify it under the terms
of the GNU Lesser General Public License as published by the Free Software Foundation; either version 2.1 of
the License, or (at your option) any later version. This library is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should have
received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby
granted to use or copy this program under the terms of the GNU LGPL, provided that the Copyright, this
License, and the Availability of the original version is retained on all copies. User documentation of any code
that uses this code or any modified version of this code must cite the Copyright, this License, the Availability
note, and "Used by permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice that the code was
modified is included.

UMFPACK Availability: http://www.cise.ufl.edu/research/sparse/umfpack UMFPACK (including versions 2.2.1
and earlier, in FORTRAN) is available at http://www.cise.ufl.edu/research/sparse. MA38 is available in the
Harwell Subroutine Library. This version of UMFPACK includes a modified form of COLAMD Version 2.0,
originally released on Jan. 31, 2000, also available at http://www.cise.ufl.edu/research/sparse. COLAMD
V2.0 is also incorporated as a built-in function in MATLAB version 6.1, by The MathWorks, Inc. http://
www.mathworks.com. COLAMD V1.0 appears as a column-preordering in SuperLU (SuperLU is available at
http://www.netlib.org). UMFPACK v4.0 is a built-in routine in MATLAB 6.5. UMFPACK v4.3 is a built-in
routine in MATLAB 7.1.

Errata
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The ADS product may contain references to "HP" or "HPEESOF" such as in file names and directory names.
The business entity formerly known as "HP EEsof" is now part of Keysight Technologies and is known as "
Keysight EEsof". To avoid broken functionality and to maintain backward compatibility for our customers, we
did not change all the names and labels that contain "HP" or "HPEESOF" references.

Qt Version 4.8.4
Qt Notice: The Qt code was modified. Used by permission.

Qt Version 4.8.4, Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies). All Rights Reserved. Contact: http://
www.qt-project.org/legal

Qt License: http://qt-project.org/doc/qt-4.8/1gpl.html. Your use or distribution of Qt or any modified version
of Qt implies that you agree to this License. This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as published by the Free Software Foundation;
either version 2.1 of the License, or (at your option) any later version. This library is distributed in the hope
that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License
for more details. You should have received a copy of the GNU Lesser General Public License along with this
library; if not, write to the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301
USA Permission is hereby granted to use or copy this program under the terms of the GNU LGPL, provided
that the Copyright, this License, and the Availability of the original version is retained on all copies.User
documentation of any code that uses this code or any modified version of this code must cite the Copyright,
this License, the Availability note, and "Used by permission." Permission to modify the code and to distribute
modified code is granted, provided the Copyright, this License, and the Availability note are retained, and a
notice that the code was modified is included.

Qt Availability: http://www.qgtsoftware.com/downloads

Patches Applied to Qt can be found in the installation at: $HPEESOF_DIR/prod/licenses/thirdparty/qt/
patches.

You may also contact Brian Buchanan at Keysight Inc. at brian_buchanan@keysight.com for more information

The HiSIM_HV source code, and all copyrights, trade secrets or other intellectual property rights in and to the
source code, is owned by Hiroshima University and/or STARC.

HDF5

HDF5 Notice: The HDF5 code was modified. Used by permission.
HDF5 Copyright: Copyright 2006-2013 by The HDF Group.

HDF5 License:

Copyright Notice and License Terms for HDF5 (Hierarchical Data Format 5) Software Library and Utilities

HDF5 (Hierarchical Data Format 5) Software Library and Utilities

Copyright 2006-2013 by The HDF Group.
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NCSA HDF5 (Hierarchical Data Format 5) Software Library and Utilities
Copyright 1998-2006 by the Board of Trustees of the University of Illinois.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted for any
purpose (including commercial purposes) provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and
the following disclaimer in the documentation and/or materials provided with the distribution.

3. In addition, redistributions of modified forms of the source or binary code must carry prominent
notices stating that the original code was changed and the date of the change.

4. All publications or advertising materials mentioning features or use of this software are asked, but not
required, to acknowledge that it was developed by The HDF Group and by the National Center for
Supercomputing Applications at the University of Illinois at Urbana-Champaign and credit the
contributors.

5. Neither the name of The HDF Group, the name of the University, nor the name of any Contributor may
be used to endorse or promote products derived from this software without specific prior written
permission from The HDF Group, the University, or the Contributor, respectively.

libpng

libpng Copyright: libpng versions 1.2.6, August 15, 2004, through 1.6.3, July 18, 2013, are Copyright (c) 2004
, 2006-2013.

libpng License: This copy of the libpng notices is provided for your convenience. In case of any discrepancy
between this copy and the notices in the file png.h that is included in the libpng distribution, the latter shall
prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately following this sentence.

This code is released under the libpng license.

libpng versions 1.2.6, August 15, 2004, through 1.6.3, July 18, 2013, are Copyright (c) 2004, 2006-2013
Glenn Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-1.2.5
with the following individual added to the list of Contributing Authors, Cosmin Truta

libpng versions 1.0.7, July 1, 2000, through 1.2.5 - October 3, 2002, are Copyright (c) 2000-2002 Glenn
Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-1.0.6 with the
following individuals added to the list of Contributing Authors

Simon-Pierre Cadieux, Eric S. Raymond, Gilles Vollant and with the following additions to the disclaimer:
There is no warranty against interference with your enjoyment of the library or against infringement. There is
no warranty that our efforts or the library will fulfill any of your particular purposes or needs. This library is
provided with all faults, and the entire risk of satisfactory quality, performance, accuracy, and effort is with
the user.



libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are Copyright (c) 1998, 1999 Glenn
Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-0.96, with the
following individuals added to the list of Contributing Authors: Tom Lane, Glenn Randers-Pehrson, Willem
van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are Copyright (c) 1996, 1997 Andreas Dilger
Distributed according to the same disclaimer and license as libpng-0.88, with the following individuals added
to the list of Contributing Authors: John Bowler, Kevin Bracey, Sam Bushell, Magnus Holmgren, Greg Roelofs,
Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January 1996, are Copyright (c) 1995, 1996 Guy Eric Schalnat,
Group 42, Inc.

For the purposes of this copyright and license, "Contributing Authors" is defined as the following set of
individuals: Andreas Dilger, Dave Martindale, Guy Eric Schalnat, Paul Schmidt, Tim Wegner

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all
warranties, expressed or implied, including, without limitation, the warranties of merchantability and of
fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect,
incidental, special, exemplary, or consequential damages, which may result from the use of the PNG
Reference Library, even if advised of the possibility of such damage.

Permission is hereby granted to use, copy, modify, and distribute this source code, or portions hereof, for any
purpose, without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.

2. Altered versions must be plainly marked as such and must not be misrepresented as being the original
source.

3. This Copyright notice may not be removed or altered from any source or altered source distribution.

The Contributing Authors and Group 42, Inc. specifically permit, without fee, and encourage the use of this
source code as a component to supporting the PNG file format in commercial products. If you use this source
code in a product, acknowledgment is not required but would be appreciated.

OpenSSL

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the
original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses are
BSD-style Open Source licenses. In case of any license issues related to OpenSSL please contact
openssl-core@openssl.org.

OpenSSL License

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.



3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use in the
OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote
products derived from this software without prior written permission. For written permission, please
contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://
www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL. This library is free for commercial and
non-commercial use as long as the following conditions are aheared to. The following conditions apply to all
code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL
documentation included with this distribution is covered by the same copyright terms except that the holder
is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this
package is used in a product, Eric Young should be given attribution as the author of the parts of the library
used. This can be in the form of a textual message at program startup or in documentation (online or textual)
provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.
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3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young (eay@
cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library being used are
not cryptographic related.

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) you must include an acknowledgement: "This product includes software written by Tim Hudson (
tih@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (
INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution license \[including the
GNU Public Licence.]

Growl GNTP support:
[The "BSD licence"] Copyright (c) 2009-2010 Yasuhiro Matsumoto
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Cuda
Cuda Redistributable Software - 1.8. Attachment A



In connection with Section 1.2.1.1 of this Agreement, the following files may be redistributed with software
applications developed by Licensee, including certain variations of these files that have version number or
architecture specific information embedded in the file name - as an example only, for release version 6.0 of
the 64-bit Windows software, the file cudart64_60.dll is redistributable.

Component : CUDA Runtime

Windows : cudart.dll, cudart_static.lib
MacOS : libcudart.dylib, libcudart_static.a
Linux : libcudart.so, libcudart_static.a
Android : libcudart.so, libcudart_static.a

Component : CUDA FFT Library
Windows : cufft.dll

MacOS : libcufft.dylib

Linux : libcufft.so

Android : libcufft.so

Component : CUDA BLAS Library
Windows : cublas.dll

MacOS : libcublas.dylib

Linux : libcublas.so

Android : libcublas.so

Component : CUDA Sparse Matrix Library
Windows : cusparse.dll

MacOs : libcusparse.dylib

Linux : libcusparse.so

Android : libcusparse.so

Component : CUDA Random Number Generation Library
Windows : curand.dll

MacOs : libcurand.dylib

Linux : libcurand.so

Android : libcurand.so

Component : NVIDIA Performance Primitives Library
Windows : nppc.dll, nppi.dll, npps.dll

MacOs : libnppc.dylib, libnppi.dylib, libnpps.dylib
Linux : libnppc.so, libnppi.so, libnpps.so

Android : libnppc.so, libnppi.so, libnpps.so

Component : NVIDIA Optimizing Compiler Library
Windows : nvwm.dll

MacOs : libnvvm.dylib

Linux : libnvvm.so

Component : NVIDIA Common Device Math Functions Library

Windows : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc
MacOs : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc
Linux : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc



Component : CUDA Occupancy Calculation Header Library
All : cuda_occupancy.h

Read more at: http://docs.nvidia.com/cuda/eula/index.html#ixzz30CrknWfU

Warranty The material contained in this document is provided "as is", and is subject to being changed,
without notice, in future editions. Further, to the maximum extent permitted by applicable law, Keysight
disclaims all warranties, either express or implied, with regard to this documentation and any information
contained herein, including but not limited to the implied warranties of merchantability and fitness for a
particular purpose. Keysight shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any information contained herein.
Should Keysight and the user have a separate written agreement with warranty terms covering the material
in this document that conflict with these terms, the warranty terms in the separate agreement shall control.
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USB3.1 Compliance Test Bench

USB 3.1 Compliance Test Bench

This section describes the following topics:

® Installing USB 3.1 Compliance Test Bench
® Difference between USB 3.0 and USB 3.1
® USB 3.1 Compliance Test Bench Simulation Setups

® Running USB 3.1 Compliance Tests on Infiniium Offline
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Installing USB 3.1 Compliance Test Bench

Installing USB 3.1 Compliance Test Bench

This section provides information on prerequisites and steps to install the USB 3.1 Compliance Test Bench (CTB).

Prerequisites

Before using the USB 3.1 CTB, ensure that the following softwares are installed:
® Infiniium Offline (Version 05.20.0010)
® USB 3.1 Compliance App (Version 2.00)
® ADS 2015.01

After installing the USB 3.1 CTB, launch the Infiniium Offline software to ensure the USB 3.1 Test App is available under
Analyze > Automated Test Apps.

File Control Setup
Offline
@ 100w [oov ! | Autormated Test Apps 1C DDR3 Test App

Measurement Analysis (EZIIT)... 5 DDR4 Test App
plete)... | U7243B USB3 Tes |

efClock Recovery (SDA)...
Equalization...

o
5
[
=
[

Install Instructions

To install the USB 3.1 CTB:

—_

. Download the USB3p1CTB.deb package.

2. Select DesignGuide > Add DesignGuide from the ADS Main window.
The Add DesignGuide dialog box is displayed.

3. Click Add Global DesignGuide.
4. Browse and select the USB3p7CTB.deb package.

5. Click Open.
The USB 3.1 Compliance Test Bench will be added.

6. Restart ADS.

7. Open a Schematic view and select DesignGuide.
The USB 3.1 Compliance Test Bench will be listed under the DesignGuide menu with the name 'USB 3.1

Compliance Test Bench'.
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Difference between USB 3.0 and USB 3.1

Difference between USB 3.0 and USB 3.1

The USB 3.1 standard also referred as USB 3 Gen2 (or Superspeed+) increases the data signal rate to 10 Gbps, double

that of USB 3.0 (referred to as USB 3 Gen1 or SuperSpeed). It reduces the line encoding overhead to just 3%, by changing
the encoding scheme to 128b/132b.

The USB 3.1 standard is also backward compatible with USB 3.0 and USB 2.0.

The following table lists the differences between the two generations of USB 3 standards.

USB 3.0 (Gen1/SuperSpeed) USB 3.1 (Gen2/SuperSpeed+)

Data Rate 5 Gb/s 10 Gb/s

Coding 8b/10b 128b/132b

Target Channel 3 meter (-17 dB @ 2.5 GHz) 1 meter (-20 dB @ 5 GHz)

CDR JTF BW 4.9Mhz JTF BW 7.5Mhz

SSC Slew rate test New df/dt requirement: 1250 (max)
ppm/us

De-emphasis Post: -3dB (Required) Pre: 2.7dB (Informative)

Post: -3dB (Informative)

RX Ref EQ CTLE CTLE + 1 tap DFE

Eye Height, TJ 100mV, 132ps(.66Ul) 70mV, 71.3ps(.714U1)
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USB 3.1 Compliance Test Bench
Simulation Setups

USB 3.1 Compliance Test Bench Simulation Setups

The USB 3.1 Compliance Test Bench provides a variety of tests, which helps to understand the various aspects of the USB
digital standard. It provides you the ability to create designs using the included models or your own models. You can refer
to the included examples when developing the designs. This Compliance Test Bench provides the following Models and

Examples:

o . M
Eid USB 3.1 Compliance Test Bengh:d T I

-

4 USB31
» Cable + Test Fidure Models
» Terminaticns
= UUSB3.1 Reference Models for Host, Cable and Device
» Channel Simulation Examples
» Channel Simulation Examples using USB3.1 Reference Models
» 5-Parameter Simulation Examples
> 5-Parameter Simulation Examples using U5B3.1 Reference Models
> Transient Simulation Examples
USE 3.1 Compliance Test Bench Documentation
About USE 3.1 Compliance Test Bench
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Models
Find below the list of models:

® Cable + Test Fixture Models: Includes models for different channels, cables, receptacles, connectors etc. which can
be used to design USB links from Transmitter to Receiver. Some of these have been used in the examples

mentioned below.
® Terminations: Includes source and load terminations.

® USB 3.1 Reference Models for Host, Cable and Device: Includes reference models for host, cable and device which
can be used to design USB links from Transmitter to Receiver. These have been downloaded from the USB-IF

website.

Examples

Find below the list of examples included in the USB 3.1 Compliance Test Bench:
® Channel Simulation Examples

® Channel Simulation Examples using USB 3.1 Reference Models

S-Parameter Simulation Examples

® S-Parameter Simulation Examples using USB 3.1 Reference Model

Transient Simulation Examples

Channel Simulation Examples

Full Link with Tx/Rx Models

This design displays a typical USB connection from Transmitter to Receiver. The signal from a Differential Transmitter
flows through the PCB traces, the Via field and the Receptacle (this part represents the Host) to reach the Cable.

From here it flows through the Receptacle, Via Field and PCB Traces (this part represents the Device) to reach the
Receiver. Eye Probes placed in the circuit display the signal leaving the Transmitter, the signal reaching the Receiver and

the signal after the Receiver Equalization.

The Transmitter transmits PRBS data at a rate of 10Gbps and uses 128b132b encoding as per USB 3.1
standard.

The Receiver Equalization consists of CTLE + DFE. This is in addition to de-emphasis applied at the
Transmitter end.
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The channel consists of PCB traces, Via field and Receptacle for both the host and device, along with a short
cable.

m The number of bits being simulated has been kept at 1000 to reduce the size of the Compliance Test

Bench. You should change it to 1000000 or more before running a practical simulation.

ol g [ b

]

fime [pa]

Gen 2 eve mask

SIGNAL FROM Tx SIGNAL BEFORE Rx EQUALIZATION SIGNALAFTER Rx EQUALIZATION

EyeDiff_Probe3 Density
5 & 8@ a8
PR ERE
EyeDiff Probed Density 2
Mask
Eye_ProbeT Density

<Diff_Probe3. measurement EyeDifi_Probe? Summary
Levell 0.43¢ Level! 0215
Leveld 0481 Level 0225
Height 0843 Height 0150
Width @ S00E-11 Width SOE-T1
ditterPP 327E 1

The waveform generated after receiver equalization is saved in the data/waveforms directory with the name FullLink.h5.

Full Link with IBIS AMI models

This design shows a typical USB connection from Transmitter to Receiver. The difference from example above is that both

the Transmitter and Receiver use IBIS AMI models.

The Transmitter AMI model provides an option to enter the pre-shoot value in addition to de-emphasis. The Receiver AMI

model provides an option to enter CTLE and DFE parameters along with the CDR parameters as well.

m The number of bits being simulated has been kept at 1000 to reduce the size of the Compliance Test

Bench. You should change it to 1000000 or more before running a practical simulation.
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The resulting eye along with measurement summary is shown below. The third eye diagram also plots the Eye Mask for
USB 3.1.

SIGNAL FROM Tx SIGNAL BEFORE Rx EQUALIZATION SIGNAL AFTER Rx EQUALIZATION

i L Ll 1]
E r o2 5 "
o B 4 |
: T |
E i ow ol 4 2
. H > &
£ L ,r': : A": -,
& 2 5 ax a
o
-
o |
o 2 @ @ @ 100 120 W3 0 130 200 | T T T T T T T T T 1
LI s S o A
e pseo
e, s
messwement measurement Ey=_Frobel Summary
= = o
i =
Height Height
Width ‘Width ‘Width
R s

The waveform generated after receiver equalization is saved in the data/waveforms directory with the name
FullLinkAMI.h5.

Cable plus fixture with Crosstalk

This design implements a channel simulation of a cable+fixture model, as shown in the USB 3.1 specifications.

With Cable
Ml wd Waez
Connasdor Conractar
Tep| |l - - Rxp
- Txn 1l - Rxn| |-
Host - i Devi
S evice
Rugp "= o= & & || Txp -
+ = I <+
< Rxn Jxmﬂ & ||| T=n :
= 10 -

It can also optionally include the effect of crosstalk, which is disabled by default. To understand the effect of crosstalk,

enable the Xtlk2_Diff component in the design.

[E3] MeasEan o
- \east Netlist Include List &= OutputWaveformPath

5
Output=Eye_Probe1.Waveform aveformPath=".

NelfistincludeList
ChannelSim - . NetisticludeList
- - . NetistType=ags
ChannelSim NetlistNamel T1="easEqn_Output.net”
ChamnelSimi1
NumberOfBits=1000
ToleranceMade=Auto ; n
EnforcePassivity=yes DE Block USB Load Term i F‘Et;
Ll X3
DE_Blockl o E S o] XSG
. . - . oy Eye_Probet
I - m (00 00)] = d -
. ~ % 1T ) %% * Rx
i | e
RATE 1™ 175¢ Bl L. L
DT 3 s PC-Block 3 R Diff
= DC_ Block2 —Fd gl
Tx_Dif2 USB_Source Tem = (000 0] | | |PCBleck3 AN DIff2
BitRate=10 Gbps. X1 = Y AT A ANy =y es
Vhigh=1.0V e o f-; fe 000 — T E=no
Viow=-1.0% C=1pF T i W s =no
RiseFalllime=a psec %T Cable_Plus_fiture_8_Port” Sfitet T fablelF yes
iode=Maximal Length LFSR L1 DC_Block
ExcludeLoad=yes USB_Lcad_Term DE_Block4 US8_Source_Temn
EQMode=Specify de-emphasis x4 x2
R=50 Ohm R=50.0nm
C=1pF C=1pl

The Transmitter transmits PRBS data at a rate of 10Gbps and uses 128b132b encoding as per USB 3.1 standard .

The Receiver Equalization consists of DFE. This is in addition to de-emphasis applied at the Transmitter end.

The number of bits being simulated has been kept at 1000 to reduce the size of the Compliance Test

Bench. You should change it to 1000000 or more before running a practical simulation.
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The resulting eye along with measurement summary is shown below. The second eye diagram also plots the Eye Mask for
USB 3.1, as specified in the USB 3.1 specifications.
SIGNAL BEFORE Rx EQUALIZATION

SIGNALAFTER Rx EQUALIZATION

o

0.0

EvyeDiff_Probe1.Density
Mask
Eve_Probel.Density

4 T B L Iy L A L B B
0 20 40 60 80 100 120 140 160 180 200 ] 20 40 60 80 100 120 140 160 180 200
time, psec time, psec
measurement EyeDiff ProDeLSummary measurement EYE Probei.summary

Level1 0269 Level1 0263

LevelD 0273 LevelD -0.270

Height 0263 Height 0.321

Width 8.250E-11 Width &.200E-11

JitterPP 1.714E 11

The waveform generated after receiver equalization is saved in the data/waveforms directory with the name Output.h5.

Cable plus fixture with IBIS AMI models with SSC

This design shows a channel simulation of a cable+fixture model using IBIS AMI models for the Transmitter and Receiver.
The difference from example #3 above is that both Transmitter and Receiver use IBIS AMI models, and there is no
CrossTalk.

£yeDiff_Fiobe

DC_Block EyeDiff Probe1
. . . . .DC_Blockd - . . . . . = == Eye_Probe
: ey
™ WA i} 0000 -
> I L Py . >
17 YVVT 1T

DC_Block

TeAM == =y = g *pC-Block: = RXAM
e - i e'0'© o) b siia ReAuia )
IbisFile="EESof,_USB3_Tx_SSC.ibS" y4 T 1r T J InisFile="EE sof_USB3_Rx ibs’
ComponentName="EEsof_USB3_Tx_R®8& ohm T o000} — T L ComponentName="EEsof_USB2_Rx"
PinName="1p" C-1pF —T |} IT- PinName="2p"
ModelName="E Esof_USB3_Tx_SSC* * Cabile_Plus_fixtuie_8_Port’ Stidgim é ModelNamie="EEsof_USB3_R"
SelAlData=yes © - . SRR Ty DG Black * * - Tﬂ- g -+ - SeAlData=yes
DataTypeSelector=Typ USB_Load_Term DC_Blockd USB_Load_Term = = DataTypeSelector=Typ
UssPlgares . . . . R L ke . & ® . UsePkg=yes
BilRate=3.973 Gbps R=500Km R2500fim & -

C=1 pF e=lEE C=1pF C=1pF

The Transmitter AMI model provides an option to enter the pre-shoot value in addition to de-emphasis. You can also enter
Spread Spectrum Clock ( SSC) parameters in this model. The Receiver AMI model provides an option to enter CTLE and
DFE parameters along with the CDR parameters as well.

The bitrate is slightly less than 10Gbps to accommodate for SSC.

m The number of bits being simulated has been kept at 1000 to reduce the size of the Compliance Test

Bench. You should change it to 17000000 or more before running a practical simulation.

The resulting eye along with measurement summary is shown below. The second eye diagram also plots the Eye Mask for
USB 3.1
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SIGNAL BEFORE Rx EQUALIZATION

EyeDiff_Probel Density

I
120 140 160 180

fime, psec
measurement EyeDiff_Probe1.Summary
Level1 0.000
Level0 0.000
Height 0.000
Width 0.000
JitterPP 0.000

1
200

Mask
Eye_Probe1 Density

SIGNALAFTER Rx EQUALIZATION

I I I T
120 140 160 180

0 20 40 60 80 100
time, psec

measurement Eye Probel.Summary
Level1 0.128

Level0 -0.128

Height 0.120

Width 6.164E-11

JitterPP 3.254E-11

The waveform generated after receiver equalization is saved in the data/waveforms directory with the name
OutputAMI.h5.

Channel Simulation Examples using USB 3.1 Reference Models

Reference Full LInk with Tx/Rx Models

This design shows a typical USB connection from Transmitter to Receiver using the USB 3.1 standard reference models
downloaded from the USB-IF website.
The host, cable and device models depicting maximum loss have been used in this design. Other reference models

provided in the CTB can also be used in this design. Eye Probes placed in the circuit display the signal leaving the

Transmitter, the signal reaching the Receiver and the signal after the Receiver Equalization.

P D
BifRate=10 Gbps
Vhign=1 1/
Viows-1 i/
RiseFailim&=g psec
Mode=Masam al-Length
ExcludeLosd=no
EQMode= Specify deemphasBt50 Ohm  Ref Hos! MRed:Ohm

== EyeDifi_Probet

ChannelSim'

ChannelSim 1

Hum berQfBits=1000

Tolerancehode=Auto

EnforePassvify=yes
=Bilbjbil

] EveDift Pmbe

[ Meastan
Meast

USB_Reference_Models=Eye. P robe1 Wavefom

Eﬂ Metlist.Include List I

[Fal

NetiistinciiceList
NetiistinchideList1
NetisiType=acs.

Netistham o[1]="MeasEqn -USB_Reference_Wodels net”

Eye_Bmbe
Eye_Pmbel

A A——p

oul =
frpoonm | J  Rr§DOnm

R=500hm 1_24 R=£D Ohm

A
: %nm .
A3

ReS00NM _Ref_Gable.| msmrnc» stdB
R=500ONM IS R=50 Ohm

A—A——p

hm ol — R
R2800hm Ref Deviee ) }mm
Eom

R=50 Ohm

RxDift * * *

Excludeload=no.

EnsbleDFE=jes

Wavefom Path="twavefoms"

200

The Transmitter transmits PRBS data at a rate of 10Gbps and uses 128b132b encoding as per USB 3.1 standard. The

Receiver Equalization consists of CTLE + DFE. This is in addition to de-emphasis applied at the Transmitter end.

The channel consists of a host, cable and device, each having maximum loss, as defined by the USB reference models.

Re

ference
Host

7dB

6dB

Reference
Device

7dB
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USB3.1 Compliance Test Bench

The number of bits being simulated has been kept at 1000 to reduce the size of the Compliance Test

Bench. You should change it to 1000000 or more before running a practical simulation.

The resulting eye along with measurement summary is shown below. The third eye diagram also plots the Eye Mask for

USB 3.1, as specified in the USB 3.1 specs doc.

SIGNAL FROM Tx SIGNAL BEFORE Rx EQUALIZATION SIGNALAFTER Rx EQUALIZATION

EyeDiff_Probe2 Density

T T 1 T T
0 0w @ ® @ oW @ 4 e s @ @ 0 W W W U e 18 @

tims, psee time, pec

S Dii_Frobe1 5 Ey=Dift_Probe2 5 wement Eye Progel.S

Level aar Level1 ol Levell a2z
Lesi0 a1 Levsi0 E

Hegnt 0440 e 0000 Heant 17
Width 250011 wWigth eemETT Width 8TETT

The waveform generated after receiver equalization is saved in the data/waveforms directory with the name
USB_Reference_Models.h5.

S-Parameter Simulation Examples

Full Link S-Parameter Modeling

This design shows the S-Parameter simulation of a typical USB connection. The results have been compared with the

corresponding design targets.

| @[ )

The Three Design Targets that are plotted in the results, along with their masks are -

1. Differential Insertion Loss
2. Near End CrossTalk(NEXT)

3. Differential to Common Mode Conversion Requirement
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Differential to Common Mode Conversion Requirement

DIFFERENTIAL INSERTION LOSS NEXT
mSDDK’: 0.5%(Si1,2)-5(1,4)5(3,2+5(3,4)) mSDDiN E_XTALK=0.5*(S(1,5)-8(1 7)}-5 3,51 5(3,7)) ﬂSDDEE: D.5%5(2,1+5(2,3)}-5(4,1)5(4 3))
Toiferential_insertion_Loss Wask=5 PP vifierential_NearE nd_XTalk_Mask=34 PR Differential_to_Commonhlode_Mask=20

A ﬂn/\fq
\WVVW il

T
.

Differential_to_Commonode_Mask
dB(3DC22)
W oE & &
%

freq, GHz

Mixed Mode S-Parameter Template

This design shows the relation between Single-Ended S-Parameters and Mixed Mode S-Parameters. You can run the

simulation to see how mixed mode S-Parameters can be derived from Single-Ended S-Parameters.

— Term S Term
| Termi 'S | Term?2
| e o S TN C )
=50 0Chm - - - | m | <o | Z2=50 Ohm -

-

-+
ol

Term

| Term4
Num=4
Z=50 Ohm

Tarm3 . . . WU7242 shor_cable_for_dev
Num=3 = X1
Z;ED_ Oh_m _

W i-F

B o

ﬁ  S-PARAMETERS I o

S Param
"SP1
" Start=9.0 GHz -
- Stop=11.0 GHz:
. Step=0.05 GHz.

The results window for this design displays the Single Ended S-Parameters, Mixed Mode S-Parameters and also the

formula to convert Single Ended S-parameters to Mixed Mode S-Parameters.
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For single-ended S-parsmeters: For mied-mode S-paramaters:

Single-ended port configuration
ri{ReZa)ir (V- {inZn})

b= (142" sqr{Re(@n} i (Vn-{In"Zn}}
S=bis

Fort1 — — Fort2

Portd — (—Fort4
{where a=stimulus, b=response)

Mibmd-mode port con fguration

S portresp. port stm

{where s=stmulus, b=respanse) Port 1 Port2

S mose resp., mode stim., port resp., port stim

Y o0t =0.54S 01, 1501 305 (3.1 53, 2)

Mixed-Mode S-Matrix
{derived from single-ended S Matrix)

P =ooiz-0 54E1 210 4 S a2 s | DRfe0c -0 s S E0 BB SR ERYEDCIZ0SS1.2 51 A} (32} 53 4)

P SO021=0.57(S(2,1 15 (2.2)-8 (4,11 5(4.3)) FMYSD022=0.57(5(2,2)-5(2,4)-5(4 2+ 5(4,4)) | TP SDC2 1=0.57(S(2 1}+5(2,I-S(4,1}-5(4.3)) aSDCLZ=Z'-515{22}+5{2.4}—5{4‘2)—5{4.4}}

TS0 =D F SIS 282 1-50.2) FRPECO2=0 5 E(1 218 (1 4+ 5(2.2-500.4) | FRPSCCTI=D IS, 1S, 3+ 82 148037 TRPECCI=0E(E1. B4R HLIHE(24)

PR S0z i=0.545(2.11-5(2 354, 11-5(4.3)) PRISCO02=058(22)5 (2 454,254 4) | FPPSCC21=0E2 A2 IHEMA50T) TIPS COII=0 52 I SRARSAIHE(H4)

C Quadrant

DD Quadrant Pure Di ial Quadrant
CC Quadrant Pure Common-mode Quadrant

CD Quadrant Differential stimulus, Common-mode response (related fo generation of EMI)
DC Quadrant Common-mode stimulus, Differential response (related fo susceptibility to E M)

4
! Mixed-mode equations f'ﬁ Single-ended S-parameters f\ Mixed-mode S-parameters /\_Alternative mixed-mode formulation /

Frequency Domain De-embedding

This design shows the process of de-embedding. When you have a composite measurement of a DUT/fixture combination

, you can isolate the performance of the fixture and use de-embedding to extract or de-embed the fixture from the

measurements.

In this example, the effect of the Receiver PCB is removed using the ADS de-embed component, to get the performance

of only the Receptacle.

3| S:PARAMETERS -

-5 -Param

sP1. . . .
Start=1.0GHz _
Stop=20.0 GHz
"Step=0.01 GHz

TJerm . . . . . . S )
wmi —— —__000Q
Num=1 5 e il =
) . . . T \ RxPCB _Receptacle .
7=50 Ohrp _l_ " Sheie
N = &
B o . De Embedd |
g erm 3 SNP1
gl—igno_gn File="TypeA_RXPCBONiy.sdp"
- AL PoriMappingType=Custom- -~ -~ -~ -~ - = 3

o

Term?2
Num=2 .
Z=50 Ohm .
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S-Parameter Simulation Examples using USB 3.1 Reference Model

USB S-Parameter Mask Template

This design compares the Differential Insertion Loss, Near End CrossTalk and Differential to Common Mode Conversion

Requirement of the USB 3.1 Standard Reference Cable model(downloaded from the USB-IF website), with the design

targets as mentioned in the USB 3.1 specifications.

The reference cable model with maximum loss(as defined by USB 3.1 specifications) is used in this design.

Num=3
© Z=50 Chrn

Iy

Tarro

. Terms
Mum=5

Tarreo

Temnk

" Z=5b Chmy

P
. TermT
 Num=7

" Term@
- Mum=8 - -
- =50 0hm .

MNum=&
 Z=50 CGhm

T Termd
© MNum=§
. Z=50 Ohm

=
T
- Num=10-
. Z=50.Ohm .

. E P STEMY

.5P1 .

cBtarElGHz,
Stop=5 0 GHe

' Btep=D 5 GH -

@ ' 5'-PARAMETERS

The results show that the model with maximum loss meet the specifications set by the USB 3.1 standard.

DIFFERENTIAL INSERTION LOSS

TS 0012=05S(1,2Y5 (1, 4-5(3,2)7S(3,4)

ma ifferential_Insertion_L oss_Mask=-6

NEXT

P S00_NE_XTALK=0.5"(SU1 61S(1.7}S(351+8(3.7))

ERJCifferential_NearEnd_XTalk_Mask=-34

Differential to Common Mode Conversion Reguirement

T s0c21=057(5(2 11+8@,3-5(4,11-8(4.3)

e iflerential_to_Commonhiode_Mask=-20
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Differential S-Parameter for Cable/Host/Device

These three design finds the Insertion Loss(at Nyquist Frequency), Near End CrossTalk and Return Loss of the USB 3.1

standard reference Cable, Host and Device models (downloaded from the USB-IF website).

Return Insertion Near End
Loss Loss Crosstalk
— N _ = N
1_ J . - 1_ —_— 1) \ [
N
o — o ll ! 1
30 ;" - 3 | PUAANN
— & A" — —
5 - 5

These values are in agreement with the frequency response shown in the presentation which is downloaded along with

the USB 3.1 reference models. The reference cable design results are compared below.

I
= mll
Term Term
" Termi T Termz
*Mum=1 - - © Mum=2Z -
. Z=50.0hm . . Z=50 Chm.
M sPA—HI
. Term . Term
. Term3 N e . Term4 |
Num=3 WA T YW Num=4
Z=50 Oh AN ——t A AN —— Z=50 Ohm
g III_[-—"VW Az500hm - Ref Cable_M +Er‘|"
. Erm “R=50Ohm -3 - T Rmm
0 TermS oo © Terms -
- Num =5 - - Mum =&
. Z=50.0hm . . Z=500hm. .
IR o | Al
. Term . . |@| S-PARAMETERS . I . Term .
Cerm? 0 . ems
MNum =7 S_Param Num =8
" Z=50'0hm ° ‘5P © Z=50 Ohm’
A  Start=0 GHz ..
- 5top=15.0 GHz:
. Step=0.05 GH=.

ADS Results -

28



USB3.1 Compliance Test Bench

INSERTION LOSS NEXT

BBl S0012=0.5"(S(1.2-5(1,415(3.21+5(3.4)) I S0031=0.5(S(1.5-5(1.7)-5(3.5+53.7)

Els0D 11=0.54S(1

mZ

RETURN LOSS

AFSI1,245(3.11+6(2,3))

o] -0

T 2] 20=5 000GHE - -

g |dB(SDD 1255518 = 5

g g -

£ Z g
] o] ]

USB-IF Results -
File Name cable_max_stda_stdb.s12p
Ca bl e Asse m b Iy Cable Loss Maximum
Host Connector Standard A
Device Connector Standard B
9 —Sdd21
—Sdd43
V7)) S S . e
o ) a
2 20} -5.9dB @5GHz ] 2
h=} b=}
2 { 2
E-30 1 g
£ £
-a0{ Insertion Loss 1
_ Return Loss
50 5 10 15 5 10 15
frequency (Hz) x 10’ frequency (Hz) x10
o
z
1]
o
2
c
j=)
(0]
£

5 10
frequency (Hz)

Transient Simulation Examples

TDR Simulation

This design shows the process of Time-Domain Reflectometry. Time-domain Reflectometry or TDR is a measurement

technique used to determine the characteristics of electrical lines by observing reflected waveforms.

TR ou WY

cogemer
nec e waveeitoy R 2snnpees
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The result shows the impedance and the reverse impedance as seen by the signal.
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e For Universal Serial Bus Specification 3.1, refer to USB_3_1_r1.0.pdf.
e For USB 3.1 Reference Channel Models, refer to Channel Model Usage - Heck - 2014-01-10.pptx.
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Running USB 3.1 Compliance Tests on
Infiniium Offline

Running USB 3.1 Compliance Tests on Infiniium Offline

In the USB 3.1 Compliance Test Bench Simulation Setups section, all Channel Simulation examples generate signal

waveforms in .h5 format. Using the Keysight Infiniium Offline software you can run the compliance test on these

waveforms.
The waveform Full_Link_wfm.h5 is used in this tutorial.

Ensure that the waveform is generated with number of bits simulated in the Channel Simulation

Controller equal to or more than 1000000.

Version 2.0 of the Infiniilum USB application supports only .wfm format for waveforms. So the .h5 waveforms have to be
converted to .wfm format before running the compliance tests.

To open the Waveform in Infiniium Offline software,

1. Start Infiniium offline.

2. Click File > Open > Waveform....
The Open Waveform File dialog box is displayed.

File| Control Setup Display Trigger Measure Math Analyze Utilities Demos Help

I rif"w ' | —_—
| Open ¥ Compos pen Waveform File

Save ¥ Setup...
Look In: waveforms

Copy Screen Image  Waveform...
Print...
Email Screen...

| Name
Full_Link_aMI_wfm.hS 135 KB Waveform Files (HDF5) 1/18/;
Full_Link_wfm.h5 62,535 KB
Cutput_wfm.h5 135 KB Waveform Files (HDF5) 1/16/;

Minimize -
Waveform Files (HDF5)

OutputAMI.hS 263 KB Waveform Files (HDF3) 1/16/;

e USB_Reference_wfm.h5 135 KB Waveform Files (HDFS) 1/16/;

User Data

Waveforms

File Name: |Full_Link_wfm.h5
Files of Type: | Waveform Files (HDF5) (*.h5)

Load Into : | Channel 1

Forced Interp Ratio: | Off

3. Click Open.
The Waveform file is displayed.
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4. Click File » Save » Waveform to save this in .wfm format.

The Save Waveform File dialog box is displayed.

Save Waveform File

My Documents

| _J
==
User Data

Waveforms

File Name: | Full_Link_wfm

Save as Type: Waveform Files (Internal) (™.wfm)

== [ all data
Waveform Source: Channel 1 Y
== @ on-screen data

Make sure to select 'all data' while saving the file.

5. Click Save.

To run the Compliance tests:

1. Click Analyze > Automated Test Apps > U7243B USB3 Test App from the Infiniium Offline software to open the

USB application.

Analyze | Utilities Demos Help

File Control Setup Display Trigger Measure Math
| Histogram... o
= o.ov

Offline = ~
— Mask Test... |
@@Ly Joov |@R | Automated Test Apps ¥ U7231B/U7231C DDR3 Test App
| Measurement Analysis (EZIIT)... | N6462A/N64628 DDR4 Test App
Jitter/Noise (EZIIT Complete)... | U7243B USB3 Test App |
RTEye/Clock Recovery (SDA)... | i
Equalization...

2N | Seap IwjL
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2. Under the Setup tab:
a. Select 10G Device
b. Select Clean Clock Reference Clock

C. Select Saved Signal from the Input Signal drop down.

File View Tools Help
D HE| "»25F |

Task Flow _| SetUp | Select Tests | Configure | Connect | Run Tests | Automation | Results | Html Report |

— Devi ~Test Point ‘Test Information

& Device ¥ TxFarEnd(TP1) [ DebugMode || Reference Clock

" Host  85C

£ HabU " Radio Friendly S5C
e o & Clean Clock

De-Emphasis Mode

W 106 I 56 e

Device ID: -

= € None
[Device 1
Test Method

~Fixture—— [Channel Sefings | [¥ USE-IF SigTest

@ Agilent  Normal Channel

 USBIF o (e W cre on

- T""" Ade for USB3.1 (dB)
it [auTo 1o =
# None (Hw channel) =

~ Input Signal ~ Test Report

Select input " = User Comments:

signal type: Saved signal -

Saved Wavelorm Setup |

-~ Transfer Function h

Load 5G InfiniiSim transfer function: \

|ransferFunctions\USE3_TX_Device_Channel {4 Browse '

Inst Setup_ |

rm'duchtm\US B3_TX_Device_Channel 4 Browse
[T Automate Extlns

v S Tests Fohwmmmmduuhemulm bommm&ﬂﬁmnzm |
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3. Under the Saved Waveform Setup tab.
a. Select Signal Type as Differential.

b. Select Signal pattern as CP10/CP9.

-
a5l Saved Waveform Setup -f'_@' —
Signal Type Signal Pattern
™ Single ended " CPUCP0 % CPID/CPY
& Differential " LFPS

Load CP10 differential signal waveform (= wim):

|
I_hn'k"-.data\wavefurrns\Full_lJnk_me.wfm Browse |

Load CP10 D+ signal waveform [~ wfm):

‘ INDne
Load CP10 D- signal waveform (~ wfm): 0
INDne
Load CPS differential signal waveform (*.wim):
| _wric\data‘waveforms'\Full_Link_wfmlwfm  Browse |
Load CPS D+ signal waveform (*.wim):
: INDne
Load CP3 O- signal waveform [~ wim):
INDne
i Dane |
A

c. Click Browse and select the Full_Link_wfm.wfm.

d. Click Done.
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4. Under the Select Tests tab

a. Select all the TP1 tests.

File View Tools Help
Dl W2 |2 %le
SetUp SelectTests |Conﬁgure| Connectl Run Tests | Automation I Resultsl Html Report

E-[]© AlUSB3 Tests
PRl B[]0 106 Test
: -[]© 106 Transmitter Low Frequency Periodic Signaling Tests
10G 5CD and LBPS Tests
10G Transmitter S5C Tests
10G eye measurement test
10G Transmitter Eye Far End (TP 1) Tests (USB-IF SigTest){CTLE On)
10G Far End Random Jitter (CTLE OM)
10G Far End Maximum Deterministic Jitter (CTLE ON)
100G Far End Total Jitter at BER-12 (CTLE ON)
10G Far End Template Test (CTLE ON)
10G Far End Differential Qutput Voltage (CTLE ON)

Select Tests

Configure

Connect

Run Tests

Test: 10G Far End Random Jitter {CTLE ON})

Pass Limits: R] <= 134 mUI

-
Description: The purpose of this test is to verify that the measured random jitter, Rj measured at TP1is @
within the limits as spedified in Table 6-19 of the USE 3.1 spedification.
Limit Set: USB 3.1 Spedification version 1.0

Reference: USB 3. 1 Spedification, Rev 1.0, Section 6.7.3, Table 6-19

=

5 Tests |Check the test(s) you would like to run Connection: UNKNOWN

N

The remaining tests in the application are not supported currently due to known issues

in the software. They will be supported in a future release of this Compliance Test
Bench and USB application.

5. Under the Connect tab.

a. Check | have completed the instructions.

b. Click Run Tests.
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File View Tools Help

D@ dE| Wi

5 tests will
be run.

1 physical
setup will be
used.

Followthese
instructions
to start
testing

Task Flow__| setUp | SelectTests | Configure  Connect | Run Tests | Automation | Resuits | Hbrl Report |

Connect to USB 3.1 receiver reference plane (SMA Connection) at TP1

Step

1. Connect your Device Under Test to the USB 3.0 test fixture. Apply VBUS to the test fixture by «
the scope.

2. Connect two phase-matched SMA cables to the receiver
Ensure correct polarity

o Connect SSTX+ to Channel 1

» Connect SSTX- to Channel 3

3. Connect SSRX+ of the test fixture to the front panel AUX OUT (or Cal Output for DSOX serie:
will automate the test pattern changing. If the automation is not successful you will be prompted to

Connection Diagram

e S R

11

— A,

Run Tests | ¥ Suppress all connection prompts

[ 5Tests  Follow instructions to connect the DUT, then press [Start] |-Cann=chnn Far End Transmitter Eye

Once the tests are completed, you can view the test results under the Results tab.

File View Tools Help

D@ dE| "»WirEr | Xk

&tm'ﬁdauTeslﬂConﬁgn'CormlRmelmmaﬁm Resllslhuﬂkmt]

Test Name [ Actual val | Mar Pass Limits

/ 10G Far End Random JNtter (CTLE ON) 160mMUl  13.0%  VALUE <= 184muUl

/' 10G Far End Maximum Deterministic Jitter (CTLE ON) -5 mul 100.9% VALUE <= 530 mUL

/' 10G Far End Total Jitter at BER-12 (CTLE ON) 1SSmUl 78.3%  VALUE <= 714mul

/ 10G Far End Template Test (CTLE ON) 0.000 100.0% VALUE = 0.000

/ 10G Far End Differential Output Voltage (CTLE ON) 178.2mV 9.6%  70.0mV <= VALUE <= 12000V

| Details: 10G Far End Random Jitter (CTLE ON)

/ a1 |

Parameter | value |
Pass Limits <= 184 mUl
Parameter Tested RJ

Actual Value 160 miJT

Referenced Values:

You can also view the HTML report under the HTML Report tab.
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File View Tools Help

DewHdHl wiErlka

SetUp

Summary of Results

Failed| 0
Passed| 5

Task Flow _| SetUp | Select Tests | Configure | Connect | Run Tests | Automation | Results  Html Report

5~ Agilent Technologies

USB3.1 Test Report

Overall Result: |55

[ TestConfigumstionbatals
[peain T
[Reterence Giock ] [ciean ciock
BB et
Test Session Details
finfinifurm W Version ] [05.20.0010
DebugMode Used 1o
|Compliance Limits (official) US5 3.1 Specification varsion 1.0

|LastTestDate  |[2015-01-22 10:53:20 UTC +05:30

References

e For Universal Serial Bus Specification 3.1, refer to USB_3_1_r1.0.pdf.

e For USB 3.1 Reference Channel Models, refer to Channel Model Usage - Heck - 2014-01-10.pptx.
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